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What is Raw Edge Applique? 
1. Raw edge applique is a fast fun way to finish quilts 
2. Raw edge applique can also be a good way to hide elements of the quilt 

top that you did not find pleasing 

• If you have a hole in the quilt top or corners or points that are not 
what you wanted, adding an applique could be just what you need 

3. Raw edge applique has edges that are not turned under 
4. The edges of raw edge applique are not covered with edge stitching 
5. Raw edge applique can be created in any shape desired 
6. If you want the edges of your raw edge applique to be more defined, stitch 

the shapes with a 1/8” seam allowance and use a heavy thread to make 
the edge stand out 

Supplies 
1. Machine and Pro-Stitcher 
2. Fusible webbing or adhesive to attach the applique pieces 
3. Thread, and the weight of the thread you select will determine the look of 

the applique 

• A heavier weight thread will sit on top of the fabric and be more 
visible 

• A lighter weight thread will sink into the weave of the fabric and will 
not show as much 
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• The color selected can also affect the look, so if you want it to look 
like you sketched in the edges, you might want to select a black or 
a charcoal grey thread 

4. Light weight bobbin thread 
5. Applique pieces 
6. A quilt top to provide the foundation for the applique pieces 

Applique Can Be Done with Different Stitches 
1. There are many different types of 

stitching that can be used to applique 
one fabric to another 

2. Needle turn applique is done with tiny 
hand stitches designed to attach the 
patch invisibly 

3. Hand sewn blanket stitch is designed to 
create a visible decorative edge around 
the applique  

4. You may have learned to do applique 
with a heavy satin stitch on your sewing machine 

• This is a type of applique that is best sewn on 
the sewing machine rather than the long arm 

• The satin egg at the right is a pot holder 
 

5. Machine stitched applique can be also be sewn with 
a variety of stitch types including:  

• Blanket stitch 

• Blind hem stitch  

• Narrow zig zag stitch 

6. If you have Art & Stitch, you can create theses looks for your long arm 
applique in the Art & Stitch software 
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• Denise will be doing a companion video showing how to use Art & 
Stitch to create raw edge applique using Art & Stitch 

7. Whimsical applique can be created with 
straight stitch lines that echo the shape of 
the applique without following it exactly  

8. Contrast thread in a straight stitch, a bean 
stitch or even stitched on the Baby Lock 
Sashiko machine can define a shape even if 
the holes in the center of the shape are not 
cut out.  

How Will the Edge of the Applique Be Covered? 
1. You have lots of options when deciding whether the edges of the applique 

are covered by the stitching  
2. There are many different projects that can be enhanced with applique 

• Tote Bags 

• Garments 

• Quilt borders 

• Quilt blocks 

• Wall hanging 
3. In any of these projects, you could choose to use 

applique that has edges that are not fully 
covered 

4. If you are designing a applique for a block you 
could create a design that fills the entire space 
and you will see that in this class  

5. Or you could design a simple shape with straight 
stitches like this flower 

6. The tote bag was created with layered applique 
pieces that were fused to the foundation fabric 

7. The tote bag was created with layer applique 
pieces that were fused to the foundation fabric 

• The dark blue curved pieces are fused 
applique 
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• The lighter blue circles with fused on top of the dark blue 

• All the applique was then stitched with the long arm  
8. The wool vest was appliqued with flowers cut with the Accuquilt cutter 

• The wool fabric was loaded on the 
frame 

• When the first flower was appliqued 
free-motion, Denise recorded the 
pattern with the Pro-Stitcher 

• The remaining flowers were stitched 
with the Pro-Stitcher using the 
recorded pattern  

• The edges of the flowers were not 
stitched all the way to the edge so 
more dimension is created by the loose 
edges on the petals 

9. The cone flower has edges with more coverage and the depth of the 
image comes from a combination of the fabrics and threads used.  

10. There are many projects where you can use raw edge applique and there 
are many ways to create raw edge applique and the choice is yours 

 

Applique Layers 
There are several layers of stitching used to create machine stitched applique 

1. A Placement stitch is the first layer of stitching and that is used to show 
exactly where the applique fabric should be placed and is 

2. If you do not want the placement stitch to show, it should be slightly 
smaller than the applique 

• You could even stitch the placement stitch with water soluble 
thread in the bobbin to make it easy to remove the placement stitch  

3. A Tack Down stitch is the second layer of stitching and that stitch is used 
to attach the applique fabric to the background fabric 
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• The tack down stitch should be slightly smaller than the placement 
stitch 

• After the tack down stitch has secured the applique fabric you can 
add any decorative stitching desired 

4. Note that if your applique pieces are not pre-cut, you can trim around the 
outside of the tack down stitching with applique scissors or small sharp 
scissors 

• Use good sharp scissors when trimming around applique 
5. The Secure stitches are the final layer of stitching 

• The Secure stitches can have as many layers as you want and 
should stitch without stopping  

6. To stitch the applique:  

• Placement stitch sews first 

• Then the Tack Down stitch sews 

• And last the Secure stitches sew 
o The Secure stitches can be “wonky” so the second time 

around the applique the stitches are not directly on top of the 
first round of stitches 

o Or the second round of stitches can sew exactly on top of 
the first round of stitches for a heavier look 

Flower Applique 

1. Select the File tab  

2. Touch Design  on the File ribbon 

3. Touch Open  

4. Go to the BL Designs/Blocks folder  

5. Select the design called Arc Shape  

6. Touch Open  

7. Touch Refresh  if desired to zoom to fit 
 
If you want to make a template of the flower to use for cutting the fabric applique 
shapes: 

1. Place a piece of Golden Threads paper on top of the quilt 
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2. Unthread your machine 
3. If you have a machine with a thread break sensor, turn the sensor off so 

you can sew with the machine unthreaded 
4. Stitch the flower with no thread and you will create a perforated pattern of 

your flower shape 
 
Another way to create a template of the flower: 

1. Insert a USB drive in the Pro-Stitcher 
2. Save the flower pattern to the flash drive 

• Touch Save  on the File Ribbon 

• Touch Selected  in the drop-down Save menu 

• Touch the arrow to close the C Drive   

• Select the D Drive  which is the USB                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    
drive you inserted 

• Save the Arc Shape pattern 
3. Insert the USB drive in the computer where your Art & Stitch is installed 
4. Open the Art & Stitch program  
5. Open the saved Arc Shape pattern in Art & Stitch 

• File 

• Import Stitch/ANS File 
6. Print the pattern 

• File 

• Print 

• Check the size and make sure the size printed is 100% 
7. You could print to an over-head projector sheet, to vellum or to a printable 

applique sheet 
 
To create the applique pattern: 

1. Go to the Edit tab   
2. Make sure the Arc Shape pattern is selected 

3. Touch Duplicate  on the Edit ribbon and you will have two copies of 
the Arc Shape pattern on the workspace 

4. The original Arc Flower pattern was 6.73” 
x 6.73”  

5. Change the copy of the Arc Flower 
pattern to 7” x 7” 

• Select the Design tab in the Side 
Bar at the right side of the 
workspace 
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• Touch the Width window to open the keypad and change the width 
to 7 inches 

• Touch the Height window to open the 
keypad and change the height to 7 
inches 

6. Move the larger flower so it is on top of the 
original flower and you can see that the 
second flower is just a little bit larger than the 
first flower 

7. The first smaller flower is the Placement 
stitching that shows where the applique 
should be placed 

8. The second slightly larger flower is the size that will be used for the fabric 
applique 

• Since it is larger than the placement stitching, it will cover that first 
layer of stitches 
 

Create the next layer of stitching 
1. Select the larger Arc Shape 

2. Touch Duplicate  on the Edit ribbon and you will have three copies of 
the Arc Shape pattern on the workspace 

• The pattern that is selected is the one that will be duplicated 
3. Touch and drag to move the third Arc Shape so it is exactly on top of the 

second one. 

• They match exactly and having two layers of stitching makes the 
outline of the larger flower darker  

4. If you select the Workspace tab  in the 
Side Bar at the right side of the page, you can 
see the three patterns listed  
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Create a fourth copy of the Arc Shape 
1. Select the larger Arc Shape 

2. Touch Duplicate  on the Edit ribbon and you will have four copies of 
the Arc Shape pattern on the workspace 

3. Touch and drag to move the fourth Arc Shape so it is exactly on top of the 
third one 
 

Rotate the new copy of the pattern 2 degrees so it is not an exact match for the 
other flowers 

1. Select the Modify tab  

2. Touch Rotate  on the Modify ribbon 

3. Touch Rotate 1° clockwise  twice in 
the Side Bar at the right side of the 
workspace to rotate the pattern 2° 

• The slightly offset stitching will give 
the applique a more modern look 
with its schetched whimsical 
appearance 

 
This could be the entire applique pattern, but what if you wanted something in the 
middle of the flower? 

1. Select the File tab  

2. Touch Design  on the File ribbon 

3. Touch Open  

4. Go to the BL Designs/Blocks folder  

5. Select the design called Closed Spiral   

6. Touch Open  
7. Touch and drag to place the Closed Spiral design in the center of the 

flower 
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• This design in the center of the flower holds the raw edge applique 
down 
 

Some notes about fusible web: 
1. If you are using fusible web be careful because some types of webbing 

can gum up the needle if they are not fully fused between two layers of 
fabric 

2. Also be careful to use a fusible web designed for sewing and that it is not 
a no-sew crafting fusible web 

3. To fuse applique in place at the frame: 

• Slide a portable sewing surface under the backing.  
o If you have a sewing pad that you use at retreats, you can 

use it for this 

• A cordless iron will be easier to use at the quilt frame 

• The applique shape can then be pressed in place right at the frame 
 
Take a look at how the design will sew: 

1. If you select the Workspace tab  in the 
Side Bar at the right side of the page, you can 
see there are now five patterns listed  

2. Each of the five designs has a start point and a 
stop point 

3. Touch Select All  and the five designs are 
merged and shown now as group 34 

4. Now the pattern has been joined so there is one 
start and one stop for the stitching around the 
outside edge of the flower, a jump to the pattern in 
the center and then one start and one stop for the 
center of the flower 
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The first option is to change the size of the Auto Jump 

1. Select the Pro-Stitcher tab  

2. Touch Quilt  on the Pro-Stitcher ribbon 

3. Touch Run  
4. The Verify Settings dialog box is displayed 
5. The Auto Jump default setting for jump stitches 

is 6 inches 
6. If you change the Auto Jump setting to zero, the 

Pro-Stitcher will never jump between these five 
designs 

7. Instead, it will stop, disable the Motors, and tell 
us to trim the top and bobbin thread. 

8. It will then move to the next location. 
9. To change the Auto Jump setting: 

• Select the Auto Jump tab  in the Side Bar at the right 

• Touch the window that shows the size of the Auto Jump 

 
• Use the key pad to change the size of the jump to zero 

 
10. With the Auto Jump set a zero, the machine will stop at the end of each of 

the five pieces of the pattern 

• It will sew the Placement stitch and stop for a bobbin pull 

• Pull up the bobbin thread and trim both threads 

• While the machine is stopped, you can also place the applique 
fabric over the Placement stitch 

• Sew the Tack Down stitch  

• The machine will stop at the end of the Tack Down Stitch for a 
bobbin pull 

• Pull up the bobbin thread and trim both threads 

• While the machine is stopped, trim the applique fabric if it was not 
already cut to the shape of the applique 

• Continue sewing to stitch the Securing stitches and the Spiral in the 
center of the flower 

• The machine will stop at the end of each layer of the stitching 
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Denise went through the second option with the Lollipop design.   
1. The second way to sew your applique is to use New Start/End 

2. Touch Select All  to merge the designs 
3. Leave the Auto Jump at the default setting of 6 inches 

4. Select the Pro-Stitcher tab  

5. Touch to select New Start & End  on the Pro-
Stitcher ribbon 

6. In the Side Bar at the right side of the page, you will 
have two scroll bars. 

• The scroll bar on the left is for the Start  

• The scroll bar on the right is for End 
7. We want the design to start at stitch zero so the pattern 

begins at the start 
8. We want the pattern to end at the first jump when it 

jumps from the Placement stitching to the Tack Down 
stitching 

9. We can find out when the first jump is by touching the 

Next Jumps arrow that points down  at the bottom 
of the Start scroll bar to move forward through the pattern to the next jump 

• The window at the top of the scroll bar shows that that jump is at 

stitch 1139  

10. Use the Jumps arrow that points up  at the bottom of the scroll bar to 
put the Start back at zero 

11. Touch the window at the top of the End scroll bar to open the key pad and 

set the End at 1139  
12. With the Start set at zero and the End set at 1139, you can sew just the 

Placement stitch and then the machine will stop for a Long Jump Pause 

• Touch Quilt  on the Pro-Stitcher ribbon 

• Touch Run  
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• Verify Stitches is displayed 

• Touch Run  

• The first circle is stitched 

• The machine stops for a Long Jump 
Pause  

• Pull the bobbin thread and trim both threads 
13. Close the Long Jump Pause dialog box 

14. Select the Pro-Stitcher tab  

15. Touch to select New Start & End  on the Pro-Stitcher ribbon 
16. This time we want to start at 1139 where we ended the first circle, but first 

we need to know where the next jump after 1139 happens 

17. Touch the Next Jump arrow  two times. 

• The first time the arrow is touched it jumps to 1139  

• The second time the arrow is touched it jumps to 2278  
18. Set the Start at 1139 and the End at 2278 and you can sew the second 

Tack Down circle 
19. When the machine stops, you can cut around the circle with applique 

scissors, or if you have the applique piece already cut you can simply 
place the applique over the stitched outline 

20. One more time, select the Pro-Stitcher tab  

21. Touch to select New Start & End  on the Pro-Stitcher ribbon 

22.  Set the Start using the Next Jump arrow  and set the End by moving 
the scroll bar all the way to the bottom so it is set at the end of the design 

23. And the Circle Scroll is stitched to Secure the applique to the quilt. 
 
Understanding the New Start & End is useful and there is another way to set a 
new Start Point. 

1. Move the machine so the needle is at the spot on the design where you 
want to begin sewing 

2. Touch Start Auto  and the stitch number for the spot where you 
aligned your needle is displayed in the window at the top of the Start scroll 
bar 
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3. Touch Start Auto  a second time and that becomes the new start 
point for the design. 

4. If you run out of bobbin thread or your needle thread breaks, this is how 
you can start sewing right where you left off. 

 
Save the design: 

1. Go to the File tab  

2. Touch Save  on the File ribbon 

3. Touch Selected  in the drop-down menu 

4. Give the design and name and touch Save  
 

Lollipop Quilt 
1. Start by deleting everything except the center of the flower applique 

2. Touch Select None   

3. Go to the File tab  

4. Select the Workspace tab  in the Side Bar at the right side of the 
page 

• The five patterns are listed on the workspace tab 
5. Touch the first Arc Shape in the list and it 

turns green to show that it is selected 

6. Touch Close  on the File Ribbon 

7. Touch Selected  in the 
drop-down menu 

8. Repeat for each of the Arc Shapes in the 
list but do not close the Closed Spiral 
pattern 

 
The Closed Spiral pattern can be used with raw edge applique to create a lollipop 
quilt 

1. Denise described a quilt with a white background that has pieced sticks for 
the lollipops 
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2. The Closed Spiral pattern can then be used to applique brightly colored 
lollipops at the top of the sticks 

3. If you want to enhance the look of the candy, you could applique with 

• Fabric 

• Fabric and tulle 

• Fabric and netting 

• Angelina fibers 

• You could felt fabric and then use it as your applique 

• There are lots of possibilities 
 

We need to create all of the layers of an applique  

1. Select the File tab  

2. Touch Design  on the File ribbon 

3. Touch Open  

4. Go to the BL Designs/Blocks folder  

5. Select the design called Circle    

6. Touch Open  
7. And the circle is placed on the workspace 

The circle is a different size than the spiral, so the circle needs to be resized so it 
is the same size as the spiral. 

1. If the Design tab  is 
selected in the Side Bar, 
the size of the selected 
design is displayed  

2. Touch to select the spiral 
design 

3. Change the size of the 
spiral to 6 inches 

• Touch the Width 
window to open the 
keypad and change 
the width to 6 
inches 
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• Touch the Height window to open the keypad and change the 
height to 6 inches 

4. Touch to select the circle design 
5. Change the size of the circle to 6 inches 

• Touch the Width window to open the keypad and change the width 
to 6 inches 

• Touch the Height window to open the keypad and change the 
height to 6 inches 

6. Touch and drag the circle design so it is right on top of the spiral pattern 

• The circle design will be our Secure layer 

• We still need the Placement and Tack Down layers 
 
Create the Placement layer 

1. The Placement layer needs to be slightly smaller than the Tack Down 
layer 

2. Go to the Edit tab  

3. Select the Workspace  tab in the Side Bar 
4. Touch to select the Circle pattern in the 

Side Bar and it turns green to show that it 
is selected 

5. Touch Duplicate  on the Edit ribbon 

6. Select the Design tab  in the Side Bar 
7. Change the size of the new circle to 5.75 

inches 

• Touch the Width window to open the 
keypad and change the width to 5.75  
inches 

• Touch the Height window to open the 
keypad and change the height to 5.75  
inches 

8. Touch and drag the circle so it is sitting 
inside the larger circle  

• And it is easy to see that this circle is 
smaller  

 
Check the sewing order. 

1. Touch the Workspace tab  in the Side Bar 
2. The duplicated circle is sewing after the original circle 
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• We need it to sew the smaller duplicated circle which is the 
Placement stitch first and then sew the larger circle to Secure the 
applique 

3. At the bottom of the Side Bar, there are arrows that can be used to move 
the selected pattern up or down in the list 

• The patterns will sew in the order 
shown in the list 

• Before you can use the arrows to 
change the sewing order, you will need 
to group the design 

4. Touch Select All  to group the patterns 
5. The group appears in the Side Bar 
6. Touch to select the last Circle pattern in the 

list which is the slightly smaller Placement 
stitching 

7. The arrows  that move the 
selected pattern up or down in the list are at the 
bottom of the Side Bar 

8. Touch the arrow that points up two times to move the 
Placement stitching to sew first 

9. Touch to select the Circle pattern which is not at the 
bottom of the list. 

• This is the Secure layer of stitching 
10. Touch the arrow that points up one time to move the 

Placement stitching to sew second 
11. And the Closed Spiral will now sew last  

 

Secure Stitching to Cover the Entire Applique 

1. Select the File tab  
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2. Touch Clear All  on the File ribbon 

3. Touch Design  on the File ribbon 

4. Touch Open  

5. Go to the BL Designs/Block folder  

6. Select the design called Circle  and touch Open  
 
Open the design that will be used to stitch over the top of the applique: 

1. Touch Design  on the File ribbon 

2. Touch Open  

3. Go to the BL Designs/Continuous Line folder  

4. Select the design called Blustery Breeze    

5. Touch Open  

6. Select the Repeat tab  

7. Select Basic  in the Repeat ribbon 

8. Touch Vertical  in the Side Bar  

9. Change the Vertical repeats to 2  
 
Create a Circle Area 

1. Select the circle 

• Select the Workspace tab  in the Side Bar 
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• Touch to select Circle in the list  

2. Select the Area tab  

3. Touch Rubber Band Area  to turn the Circle pattern into a circular 
Area 

 
Transform the Blustery Breeze pattern: 

4. Select the Blustery Breeze design 

• Select the Workspace tab  
in the Side Bar 

• Touch to select Blustery Breeze in 
the list  

5. Touch XForm  (Transform) in the Quick Access tool bar at the left 
side of the workspace 

6. Touch and drag one of the control squares at a corner of the pattern to 
make the pattern smaller  

7. Touch and drag to move the Blustery Breeze pattern so it covers the circle 
 
 
Crop the Blustery Breeze pattern 

1. Select the Modify tab  

2. Touch Crop  on the Modify ribbon 

3. Select Crop Outside  in the Side Bar  
4. And now there is stitching that fills the circle 

shape of the applique 
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5. All the red and green dots along the edges of the circle are starts and 
stops 

6. To join those starts and stops, touch Edges  
in the Side Bar 

7. And the starts and stops along the edge of the 
circle are joined with stitches along the edge of 
the circle and there is just one green start and 
one red end  

8. You can move the XForm (Transform) to choose 
exactly which part of the design is used inside 
the circle 

9. The Blustery Breeze stitches will be the Secure stitching on the applique, 
but we also need to create the other layers of stitching needed for the 
applique. 

 

Create the Placement & Tack Down Stitches 

1. Select the Workspace tab  in the 
Side Bar 

2. Touch to select the Circle  

3. Go to the Edit tab  

4. Touch Duplicate  on the Edit ribbon to 
create another circle 

5. Touch XForm  in the Quick Access tool bar at the left side of the 
page to turn that function off 

6. If you touch the original circle on the Workspace tab in the Side Bar, you 
can see that the original circle was 6 inches 

• The new circle created with Duplicate needs to be slightly smaller 
than the original circle 

7. Touch the new circle on the Workspace tab in the Side Bar 
8. Change the size of the new circle to 5.75 inches 

• Touch the Width window to open the keypad and change the width 
to 5.75 inches 

• Touch the Height window to open the keypad and change the 
height to 5.75 inches 

9. Now we have all of the layers needed for the applique 

• The original 6-inch circle for Placement 

• The slightly smaller 5.75-inch circle for Tack Down 
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• And the Blustery Breeze circle for Securing stitches 
 

Align the layers: 

1. Select the Workspace tab  in the Side Bar 
2. Touch to select the Circle design at the top of the list 

3. Select the Modify tab  

4. Touch Align  on the Modify tab 
5. Select Horizontal Center and Vertical Center in the Side 

Bar  

6. Return to the Workspace tab  in the Side Bar 
7. Touch to select the second design in the list 

8. Return to the Modify tab  

9. Touch Align  on the Modify tab and select 
Horizontal Center and Vertical Center in the Side Bar  

10.  Repeat these steps for each layer of the applique pattern 

11. Select the File tab  
12. Save the pattern 

13. Touch Clear All  on the File ribbon  
 

Bird Applique 

1. Select the File tab  

2. Touch Design  on the File ribbon 

3. Touch Open  

4. Go to the BL Designs/Blocks folder  

5. Select the design called Bird Fill  
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6. Touch Open  

• This bird is filled with motif stitches 
7. This bird is an ideal pattern to become an applique because like the 

previous exercise the bird is filled with stitches which would cover and 
secure the applique 

 
The simulator can be used to preview how the design is going to sew. 

1. Go to the Pro-Stitcher tab  

2. Touch Run  

3. If you are using the Simulator, you can then touch Proceed  and 
watch how the design stitches 

4. If you are running Pro-Stitcher, turn off Stitch  in the Side Bar 

• You will then be able to “Air Stitch” the pattern 

• The machine will move through the pattern but the needle will not 
sew and you will be able to see how the pattern stitches 

 
The bird does not have a continuous outline 

1. The pattern starts to sew the outline of the bird 

• The lines turn gold as they are stitched 

2. But then the stitching path moves into the motif stitches and begins filling 
the center of the pattern 

• Quilt patterns like this one are optimized to find the best sewing 
path that can sew without 
unnecessary jumps and to back 
track over the same stitching lines 
only when necessary to keep the 
stitching line continuous 
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3. And if you look closely, you will find that there are some gaps in the outline 
of the bird 

4. The question is, “Can this design be used as an applique since it does not 
sew a continuous outline around the perimeter of the pattern?” 

5. Yes, the bird will work as an applique, but it will be stitched with just the 
one layer of stitching. 

• Use a fabric glue stitch instead of fusing the fabric in place 

• Glue the uncut bird fabric to the quilt top 

• Stitch the bird 

• Use small sharp scissors to trim close to the stitching  
6. If you wanted to create a full outline for the bird, you could take the bird 

pattern into Art & Stitch to create that outline. 

• This could be another reason why you might also like to view 
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companion video showing how to use Art & Stitch to create raw 
edge applique using Art & Stitch 

 

Chenille Stars 

1. Select the File tab  

2. Touch Design  on the File ribbon 

3. Touch Open  

4. Go to the Linda Matteotti folder  
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5. Select the design called Star Block 

 

6. Touch Open  
7. This design could be used to create reverse 

applique chenille stars 
8. Place four layers of cotton flannel on top of 

the quilt 
9. Sew the Star Block pattern  
10. Cut the layers of fabric inside the stars 

leaving a small edge to create reverse 
applique chenille stars 

11. You could also cut around the outside of the block so the pattern also 
becomes a raw edge applique 

 
Denise suggests trying any of these raw edge applique techniques on a small 
test project before you commit to doing it on a large quilt 
 
 
 
 
 
 
 
 


